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8.Εισαγωγή εξωτερικών αρχείων στο Flash 

Εισαγωγή στις εικόνες 

Το Flash  παρέχει πολλά σχεδιαστικά εργαλεία. Ωστόσο, συχνά χρειάζεται να εισάγετε 

εικόνες οι οποίες δεν μπορούν να δημιουργηθούν στο Flash. Τέτοιες εικόνες είναι: 

 φωτογραφίες,  

 ανυσματικά γραφικά,  

 υπάρχοντα γραφικά όπως το εταιρικό λογότυπο και άλλα. 

 Ως σχεδιαστές, πρέπει να αποφασίσετε σε ποια περίπτωση είναι καλύτερο να φτιάξετε οι 

ίδιοι εικόνες και σε ποια να τις εισάγετε από κάπου. Τα κριτήρια για την απόφαση αυτήν 

είναι το μέγεθος των αρχείων και οι διαθέσιμες πηγές. 

 

Οι μορφές των εικόνων που υποστηρίζονται από το Flash 

Το Flash υποστηρίζει μια γκάμα εικόνων. Καλό είναι να οι εικόνες να έχουν υποστεί την 

επεξεργασία που χρειάζεται και να έχουν το κατάλληλο μέγεθος πριν εισαχθούν στο Flash. 

Οι ποιο κοινές μορφές αρχείων που χρησιμοποιούνται από το Flash είναι: 

 PNG: Αυτή η μορφή αρχείου χρησιμοποιείται από το Adobe Fireworks. Υπάρχει μια 

συνεργασία μεταξύ του Flash και του Fireworks. Αυτό σημαίνει ότι μπορείτε να 

ανοίξετε ένα αρχείο PNG στο Flash, να το επεξεργαστείτε στο Fireworks και να δείτε 

τις αλλαγές του αρχείου στο Flash αυτόματα. 

 JPEG: Αυτή η μορφή είναι συμπιεσμένη και χρησιμοποιείται για φωτογραφίες στο 

web. Πριν εισάγετε μια φωτογραφία στο Flash, ανοίξτε την με το Fireworks για να 

την συμπιέσετε. Μπορείτε να ανοίξετε ένα αρχείο JPEG στο Flash, να το 

επεξεργαστείτε στο Fireworks και να δείτε τις αλλαγές του αρχείου στο Flash 

αυτόματα. 

 GIF, BMP: Τα αρχεία αυτά πρέπει να τα βελτιστοποιήσετε, optimize, με το Fireworks 

και έπειτα να τα εισάγετε στο Flash. 

 Adobe Photoshop και Adobe Illustrator vector files: Αυτά τα αρχεία εισάγονται 

πλήρως με επίπεδα, καρέ και σύμβολα. 
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Εικόνες ανυσματικές και bitmap 

Οι εικόνες bitmap αποτελούνται από 
pixels ποικίλου χρωματισμού τα οποία 
συνθέτουν την εικόνα. Τα γραφικά και 
οι φωτογραφίες που αποθηκεύονται 
σε μορφή GIF και JPEG είναι εικόνες 
bitmap.  Όταν φτιάχνετε μια εικόνα 
bitmap, στην ουσία ορίζετε το χρώμα 
σε κάθε pixel. 
 
Οι bitmap εικόνες είναι εξαρτώμενες 
από την ανάλυση της οθόνης – 
resolution dependent.  Αυτό σημαίνει 
ο μέγεθος και η ποιότητα της εικόνας 
εξαρτώνται από τον αριθμό των pixels 
ανά ίντσα (dots per inch – dpi).  Μια 
εικόνα που θα προβληθεί στην οθόνη,  
έχει 72 pixels ανά ίντσα επειδή οι 
περισσότερες οθόνες υποστηρίζουν 
αυτήν την ανάλυση.  Μια εικόνα 
αποθηκευμένη για εκτύπωση, μπορεί 
να έχει μέχρι 300 pixels ανά ίντσα. 
 
Σε αντίθεση με τις εικόνες bitmap, οι 
ανυσματικές εικόνες (εικόνα 1) δεν 
είναι φτιαγμένες pixels προς pixel. Οι 
ανυσματικές εικόνες χρησιμοποιούν 
μια σειρά από εντολές οι οποίες 
καθορίζουν διάφορες ιδιότητες της 
γραμμής όπως:  

 το σχήμα,  

 το πάχος,  

 την τοποθεσία  

 και το χρώμα.  
Το βασικό σχήμα σε μια τέτοια εικόνα 
επανασχεδιάζεται, rendered, κάθε 
φορά που το βλέπουμε στην οθόνη. 
 
Η εξ’ ορισμού μορφή των αρχείων 
στο Flash είναι ανυσματική, επειδή οι 
εικόνες αυτές παράγουν μικρότερο σε 
μέγεθος αρχεία. Ωστόσο, όπως έχει 
είδη αναφερθεί, μπορείτε να εισάγετε 
μια bitmap εικόνες στο Flash όταν τις 
χρειάζεστε. 

Εικόνα 1 

 

 

 



4 
 

Εισαγωγή Εικόνων στο Σκηνικό 

Όταν εισάγετε μια εικόνα στο σκηνικό, η εικόνα αυτόματα τοποθετείται μέσα στην 

βιβλιοθήκη. 

1. Ξεκινήστε το Flash και ανοίξτε ένα 

έγγραφο μέσα στο οποίο θέλετε να 

εισάγετε μια εικόνα. 

2. Επιλέξτε το επίπεδο στο οποίο 

θέλετε να εμφανίζεται και επιλέξτε 

το σκηνικό. 

3. ΕπιλέξτεFile > Import > Import to 

Stage. 

Ανοίγει το πλαίσιο διαλόγου Import 

(Εικόνα 1). 

4. Αναζητήστε τον φάκελο στον οποίον 

βρίσκεται η εικόνα. 

5. Επιλέξτε την. 

6. Πατήστε Open. 

Η εικόνα εμφανίζεται στο σκηνικό, στο 

επιλεγμένο επίπεδο και παράλληλα 

εμφανίζεται μέσα στην βιβλιοθήκη. 

Σημείωση: Για να την επεξεργαστείτε, 

επιλέξτε την στο σκηνικό και στον 

επιθεωρητή ιδιοτήτων πατήστε το κουμπί 

Edit. Το Flash ανοίγει το Fireworks, στο 

οποίο μπορείτε να επεξεργαστείτε την 

εικόνα και να επιστρέψετε στο Flash όταν 

τελειώσετε.  

 

Εικόνα 1 Το πλαίσιο διαλόγου Import 
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Εισαγωγή Εικόνων στην Βιβλιοθήκη 

Όταν εισάγετε μια εικόνα στην βιβλιοθήκη, η εικόνα είναι έτοιμη για χρήση αλλά δεν έχει 

τοποθετηθεί μέσα στο έγγραφο. 

1. Ξεκινήστε το Flash και ανοίξτε ένα 

έγγραφο μέσα στο οποίο θέλετε να 

εισάγετε μια εικόνα. 

2. Επιλέξτε το επίπεδο στο οποίο 

θέλετε να εμφανίζεται και επιλέξτε 

το σκηνικό. 

3. ΕπιλέξτεFile  >  Import > Import to 

Library. 

4. Εάν η βιβλιοθήκη δεν είναι ανοιχτή, 

επιλέξτε Window > Library. 

Η εικόνα εμφανίζεται μέσα στην βιβλιοθήκη 

(Εικόνα 2) . 

5. Επιλέξτε την εικόνα στην βιβλιοθήκη 

για να την δείτε ως προεπισκόπηση. 

 

Εικόνα 2 Η βιβλιοθήκη του Flash με την 

εικόνα 
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Εισαγωγή αρχείου PNG του Fireworks 

Όταν εισάγετε ένα αρχείο PNG του Fireworks, το Flash σας επιτρέπει να ρυθμίζετε ορισμένα 

στοιχεία του PNG αρχείου όπως επίπεδα και κείμενο. 

1. Ξεκινήστε το Flash και ανοίξτε ένα 

έγγραφο μέσα στο οποίο θέλετε να 

εισάγετε μια εικόνα PNG του 

Fireworks. 

2. Επιλέξτε το επίπεδο στο οποίο 

θέλετε να τοποθετήσετε την εικόνα 

και επιλέξτε το σκηνικό. 

3. ΕπιλέξτεFile > Import > Import to 

Stage. 

Ανοίγει το πλαίσιο διαλόγου Import 

(Εικόνα 1). 

4. Αναζητήστε τον φάκελο στον οποίον 

βρίσκεται η PNG εικόνα. 

5. Επιλέξτε την. 

6. Πατήστε Open. 

Ανοίγει το πλαίσιο διαλόγου Import 

Fireworks Document (Εικόνα 3). 

7. Το Flash σας ρωτάει αν θέλετε να 

διατηρήσετε τα επίπεδα του 

Fireworks. Για να μείνουν τα 

επίπεδα άθικτα, επιλέξτε Import as 

to maintain appearance. 

8. Το Flash σας ζητάει αν θέλετε να 

διατηρήσει τα αντικείμενα και το 

κείμενο του PNG αρχείου ή να τα 

κάνει επεξεργάσιμα – editable. 

 Για να παραμείνουν τα τμήματα της 

εικόνας επεξεργάσιμα, επιλέξτε 

Keep all paths editable. 

 Για να παραμείνει το κείμενο 

επεξεργάσιμο, επιλέξτε Keep all 

text editable. 

 

Εικόνα 3 Το πλαίσιο διαλόγου Import 

Fireworks Document 
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9. Πατήστε OK. 

Το Flash εισάγει την PNG εικόνα. Η εικόνα 

εμφανίζεται στο σκηνικό και στην 

βιβλιοθήκη. 
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Εισαγωγή Ελεύθερου σχεδίου και άλλων Ανυσματικών 
Γραφικών 

Τα προγράμματα ανυσματικών γραφικών όπως είναι το Adobe Photoshop και Adobe 

Illustrator υποστηρίζουν επίπεδα και καρέ. Για τον λόγο αυτόν, το Flash σας υπολογίζει τα 

χαρακτηριστικά αυτά κατά την διαδικασία εισαγωγής τέτοιων εικόνων. 

1. Ξεκινήστε το Flash και ανοίξτε ένα 

έγγραφο μέσα στο οποίο θέλετε 

να εισάγετε ένα αρχείο του 

Photoshop. 

2. Επιλέξτε το επίπεδο στο οποίο 

θέλετε να εμφανίζεται και 

επιλέξτε το σκηνικό. 

3. ΕπιλέξτεFile > Import > Import to 

Stage. 

Ανοίγει το πλαίσιο διαλόγου Import 

(Εικόνα 1). 

4. Αναζητήστε τον φάκελο στον 

οποίον βρίσκεται το αρχείο. 

5. Επιλέξτε το. 

6. Πατήστε Open. 

Ανοίγει το πλαίσιο διαλόγου Import 

filename.PSD to Library (Εικόνα 4). 

Τσεκάρετε τα επίπεδα Layers του 

αρχείου τα οποία θέλετε να εισάγετε.  

Για κάθε  ένα επίπεδο το οποίο 

επιλέγετε, μποροείτε να ρυθμίσετε τις 

παραμέτρους του ανάλογα με τον τύπο 

του επιπέδου. 

Μπορείτε επίσης, να μετατρέψετε τις 

τα επίπεδα του αρχείου προέλευσης 

σε επίπεδα Flash ή σε καρέ κλειδιά. 

 

Εικόνα 4 Το πλαίσιο διαλόγου Import 

filename.PSD to Library 

 

  



9 
 

H λειτουργία Trace Bitmap 

Όταν έχουμε ένα σχέδιο με γέμισμα εικόνας, μπορούμε να μετατρέψουμε την εικόνα ως 

γραφικό.  

Για να το κάνουμε αυτό, κάνουμε κλικ στην εικόνα και επιλέγουμε από το μενού Modify > 

Bitmap > Trace Bitmap. Στο πλαίσιο διαλόγου θέτουμε κάποιες παραμέτρους όπως το 

εύρος των χρωμάτων και των pixels που θα γίνουν ένα ενιαίο σχήμα. Ανάλογα με την 

εικόνα, το επιθυμητό αποτέλεσμα κάθε φορά βγαίνει με διαφορετικές παραμέτρους οπότε 

καλό είναι να γίνεται πειραματισμός μέχρι να καταλήξουμε σε ένα επιθυμητό αποτέλεσμα. 

Το αποτέλεσμα είναι μια εικόνα με εμφάνιση cartoon.  Αφού γίνει αυτό, μπορούμε με 

μεταβάλουμε το σχήμα και το χρώμα των επιμέρους σχημάτων. 
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Εισαγωγή ήχου 

Στο Flash  μπορείτε να ενσωματώσετε ήχο και βίντεο στην λωρίδα χρόνου, ανεβάζοντας με τον τρόπο 

αυτόν την ποιότητα και τον έλεγχο της ταινίας. 

Εισαγωγή 

Μπορείτε  να χρησιμοποιήσετε ήχο για πολλούς λόγους στο Flash όπως soundtracks, αφηγήσεις και 

ηχητικά εφέ τα οποία συνδέονται με αντικείμενα όπως κουμπιά. 

 

Στο Flash μπορείτε να εισάγετε τους ακόλουθους τύπους αρχείων ήχου: 

 WAV (Windows only)  

 AIFF (Macintosh only)  

 MP3 (Windows or Macintosh)  

Εάν στον υπολογιστή σας έχετε εγκατεστημένο το QuickTime, έκδοση 4 και άνω, μπορείτε να 

εισάγετε επιπλέον τις ακόλουθες μορφές ήχων: 

 AIFF (Windows or Macintosh)  

 Sound Designer II (Macintosh only)  

 Sound Only QuickTime Movies (Windows or Macintosh)  

 Sun AU (Windows or Macintosh)  

 System 7 Sounds (Macintosh only)  

 WAV (Windows or Macintosh)  

 

Όταν εισάγετε ένα αρχείο ήχου, αυτό τοποθετείται μέσα στην βιβλιοθήκη. Έπειτα, μπορείτε να 

σύρετε ένα στιγμιότυπο (αντίγραφο) του ήχου στο σκηνικό. Ένα αρχείο ήχου, ενσωματώνεται σε 

καρέ κλειδιά. Όταν εισαχθεί ο ήχος βλέπουμε στο καρέ κλειδί και στα κερέ που έπονται μια 

κυματομορφή. 

 

Μπορείτε να συγχρονίσετε έναν ήχο στην ταινία σας με ποικίλους τρόπους (Επιλογές  Sync της 

παλέτας properties): 

 Event: Ο ήχος ξεκινάει να παίζει όταν η κεφαλή αναπαραγωγής φτάσει στο πρώτο καρέ 

κλειδί το οποίο περιέχει τον ήχο. Ο ήχος παίζει ανεξάρτητα με το αν η ταινία σταματήσει. 

Εάν ξεκινήσει να παίζει ένα διαφορετικό στιγμιότυπο του ίδιου ήχου, τότε αυτό επικαλύπτει 

τον προηγούμενο. 

 Start: Το ίδιο με το event αλλά με την διαφορά ότι εάν παίζει ένας ήχος, δεν μπορεί να 

διακοπεί από κάποιο άλλο στιγμιότυπο. 

 Stop: Διακόπτει τον ήχο. 

 Stream: Η αναπαραγωγή του ήχου συμβαδίζει με την αναπαραγωγή της ταινίας. Εάν το 

Flash καθυστερήσει στον σχεδιασμό κάποιων καρέ, θα τα παρακάμψει. Σε αντίθεση με το 

event, ο ήχος σταματάει όταν σταματήσει η ταινία. Με την ρύθμιση αυτήν, το αρχείο που 

παράγεται είναι μικρότερο σε μέγεθος αλλά η ποιότητα ήχου είναι κατώτερη. 
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Εισάγοντας ήχο 

1. Ξεκινήστε το Flash και ανοίξτε ένα 

έγγραφο. 

2. Εισάγετε ένα νέο επίπεδο. 

3. Κάντε διπλό κλικ στο όνομα και 

ονομάστε το  Sound. 

4. Επιλέξτε File > Import > Import to Stage. 

Ανοίγει το πλαίσιο διαλόγου Import  (Εικόνα 1). 

5. Αναζητήστε το αρχείο ήχου, επιλέξτε το 

και πατήστε Open. 

Σημείωση: Μπορείτε να κατεβάσετε ήχους και 

εφέ από το http://www.flashkit.com. 

6. Επιλέξτε το καρέ 1 του επιπέδου Sound. 

7. Βεβαιωθείτε πως η παλέτα Library είναι 

ανοιχτή (Εάν όχι, επιλέξτε 

Windows>Library). 

Ο ήχος εμφανίζεται στην παλέτα Library. Για να 

τον ακούσετε, πατήστε το κουμπί Play στην 

παλέτα προεπισκόπησης  

(Εικόνα 2). 

Σημείωση: Για να δείτε την κυματομορφή του 

ήχου, πρέπει να τον επιλέξετε πρώτα. 

8. Σύρετε το αρχείο ήχου από την 

βιβλιοθήκη στο σκηνικό. 

Σημείωση: Το επίπεδο Sound πρέπει να περιέχει 

τόσα καρέ όσα χρειάζονται για να μπορεί να 

παίξει ο ήχος ολόκληρος. Για παράδειγμα, εάν η 

ταινία σας παίζει 12 καρέ το δευτερόλεπτο και ο 

ήχος έχει διάρκεια 2 δευτερόλεπτα, τότε το 

επίπεδο Sound πρέπει να αποτελείται 

τουλάχιστον από 24 καρέ. Εάν εισάγετε ένα καρέ 

κλειδί σε ένα σημείο της κυματομορφής, ο ήχος 

θα κοπεί. 

9. Εάν χρειάζεται, προσθέστε επιπλέον 

καρέ στο επίπεδο Sound. Για να το 

κάνετε αυτό, κάντε κλικ στο καρέ 24, για 

ήχο διάρκειας 2 δευτερολέπτων, και 

επιλέξτε Insert > Frame. 

Ο ήχος δεν εμφανίζεται στο σκηνικό, αλλά στην 

λωρίδα χρόνου ως κυματομορφή (Εικόνα 3). 

 

Εικόνα 1 Το πλαίσιο διαλόγου Import 

 

 

Εικόνα 2 Η παλέτα Library 

 

 

Εικόνα 3 Ο ήχος στην λωρίδα χρόνου 

 

 

http://www.flashkit.com/
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Επεξεργασία του ήχου 

Μέσω του επιθεωρητή ιδιοτήτων και στην περιοχή Sound, μπορείτε να ρυθμίσετε τον ήχο όπως την 

σταδιακή σίγαση του (Fadeout). 

Επιλέξτε το πρώτο καρέ κλειδί και ρυθμίστε 

τις ιδιότητες του ήχου στον επιθεωρητή 

ιδιοτήτων (Εικόνα 4). 

Name: Από την αναδιπλώμενη λίστα επιλέγετε 

τον ήχο. 

Effect: Επιλέξτε κάποιο από τα εφέ όπως το Fade 

In, Fade Out, αναπαραγωγή του ήχου από ένα 

μόνο κανάλι (αριστερό ή δεξί), μετάβαση του 

ήχου από το ένα κανάλι στο άλλο (Εικόνα 5). 

Επιλέγοντας Custom θα ανοίξει ένα παράθυρο 

επεξεργασίας ήχου στο οποίο μπορείτε να 

δώσετε τα δικά σας εφέ (Εικόνα 6). Στο 

παράθυρο Edit Envelope, ρυθμίστε τις λαβές του 

ήχου ελέγχοντας έτσι την ένταση του ήχου σε 

κάθε κανάλι. 

Sync: Επιλέξτε Event, Start, Stop ή Stream. 

Repeat:  Επιλέξτε πόσες φορές θέλετε να 

επαναληφθεί ο ήχος. 

 

Εικόνα 4 Επιθεωρητής των ιδιοτήτων του ήχου 

 

 

Εικόνα 5 Το μενού pop-up 

 

 

Εικόνα 6 Το πλαίσιο διαλόγου Edit Envelope 
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Συμπίεση ήχου 

Μπορείτε να μειώσετε το μέγεθος των αρχείων ήχου σε πολύ μεγάλο βαθμό. Ένας τρόπος για να το 

κάνετε αυτό είναι η συμπίεση. 

1. Βεβαιωθείτε πως είναι ανοιχτή η 

παλέτα βιβλιοθήκη και επιλέξτε το 

αρχείο ήχου. 

2. Πατήστε το κουμπί Properties στο κάτω 

μέρος της παλέτας βιβλιοθήκης (Εικόνα 

7). 

Ανοίγει το πλαίσιο διαλόγου Sound Properties 

(Εικόνα 8). 

3. Επιλέξτε μια μέθοδο συμπίεσης από το 

μενού Compression και πατήστε OK. 

ADCPM: Αυτή η μέθοδος συμπίεσης υπάρχει 

από την έκδοση 3 του Flash. Θέτει την συμπίεση 

του ήχου στα 8-bit και 16-bit. Είναι χρήσιμη εάν 

ανοίξετε την ταινία σας με το Flash 3. 

MP3: Η μέθοδος αυτή παράγει ήχους για την 

έκδοση Flash 4 και μετά. Παράγει ικανοποιητική 

συμπίεση και αξιοπιστία ήχου. 

Raw: Με αυτήν ρυθμίζετε την δειγματοληψία 

του ήχου αλλά δεν τον συμπιέζει. 

Speech: Συμπιέζει ικανοποιητικά αρχεία ήχου 

που περιέχουν αφήγηση. 

4. Αποθηκεύστε την ταινία σας. 

5. Επιλέξτε Control > Test Movie. 

 

Εικόνα 7 Το κουμπί Properties της βιβλιοθήκης 

 

 

Εικόνα 8 Το πλαίσιο διαλόγου Sound Properties 
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Προσθήκη ήχου στο κουμπί 

Μπορείτε να προσθέσετε ήχο σε ένα κουμπί έτσι ώστε όταν οι επισκέπτες κάνουν κλικ επάνω του, να 

ακούγεται ένας ήχος. 

1. Κάντε διπλό κλικ στο κουμπί για να μπείτε 
σε κατάσταση symbol-editing, 

2. Εισάγετε ένα επίπεδο και ονομάστε το 
Sound. 

3. Εισάγετε έναν σύντομο ήχου στην 
βιβλιοθήκη. Μπορείτε να κατεβάσετε ήχους 
και από το http://www.flashkit.com 

4. Στο επίπεδο Sound, εισάγετε ένα καρέ 
κλειδί στην κατάσταση του κουμπιού στην 
οποία θέλετε να ακουστεί ο ήχος. 

Εάν, για παράδειγμα, θέλετε να ακουστεί 

όταν ο χρήστης μετακινήσει τον δείκτη 

επάνω από το κουμπί, προσθέστε ένα καρέ 

κλειδί στην κατάσταση Over. 

5. Κάντε κλικ στο νέο καρέ. 

6. Βεβαιωθείτε πως είναι ανοικτός ο 
επιθεωρητής ιδιοτήτων (επιλέξτε  
Windows>Properties). 

7. Στον επιθεωρητή ιδιοτήτων και από το 
μενού Sound, επιλέξτε έναν ήχο (Εικόνα 9). 

8. Από το μενού Synchronization επιλέξτε 
Event. 

9. Ο ήχος θα αναπαραχθεί όταν ο χρήστης 
κάνει περάσει τον δείκτη του ποντικιού 
επάνω από το κουμπί. 

 

Εικόνα 9 Ο επιθεωρητής ιδιοτήτων για το καρέ 

 

  

http://www.flashkit.com/
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Το βίντεο στο Flash 

Οι περισσότεροι χρήστες στο web βλέπουν βίντεο μέσω flash παρά με άλλα προγράμματα όπως το 

Quick Time. Τα βίντεο στα περισσότερα sites προβάλλονται μέσω  

Μπορείτε να παρουσιάσετε ένα εξωτερικό βίντεο ως ξεχωριστό αρχείο και να αναπαράγεται μέσω 

ενώς στοιχείου αναπαραγωγής στο Flash ή να το ενσωματώσετε κατευθείαν στο αρχείο flash.  

Το Flash υποστηρίζει  πολλούς τύπους βίντεο. 

Με εγκατεστημένο το QuickTime (έκδοση 4 και άνω), μπορείτε να εισάγετε τους ακόλουθους 

τύπους βίντεο: 

 Audio Video Interleaved (.avi) 

 Digital Video (.dv) 

 Motion Picture Experts Group (.mpg ήmpeg) 

 Quick Time (.mov) 

Με εγκατεστημένο το DirectX 7, μπορείτε να εισάγετε ακόλουθους τύπους βίντεο: 

 Audio Video Interleaved (.avi) 

 Motion Picture Experts Group (.mpg ήmpeg) 

 Windows Media File (.wmv, .asf) 

 

Πρέπει να έχουμε εγκατεστημένο ένα από τα δύο παραπάνω προγράμματα προκειμένου να 

μπορούμε να εισάγουμε βίντεο στο Flash. 

Πριν την εισαγωγή του, ένα βίντεο πρέπει να μορφοποιηθεί σωστά. Η κατάλληλη μορφή 

βίντεο είναι η μορφή Flash Video με επέκταση .flv ή .f4v. Η ποιο πρόσφατη μορφή είναι η 

f4v που υποστηρίζει το πρότυπο H.264. Το πρότυπο αυτό είναι μια μέθοδος κωδικοποίησης 

αιχμής η οποία προσφέρει υψηλή ποιότητα με ιδιαίτερα αποτελεσματική συμπίεση. Αυτή η 

μέθοδος συμπίεσης ονομάζεται codec από τις λέξεις compression/decompression, 

συμπίεση/ αποσυμπίεση, και χρησιμοποιήται σε υπολογιστές για την συμπίεση ενός 

αρχείου βίντεο προκειμένου να γίνει εξοικονόμηση χώρου και κατόπιν, για την 

αποσυμπίεσή του ώστε να αναπαραχθεί το αρχείο. Το flv είναι μια πρότυπη μορφή για 

προηγούμενες εκδόσεις του Flash και χρησιμοποιεί τα παλαιότερα codec Sorenson Spark 

και On2VP6. 
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Χρήση του Adobe Media Encoder 

Η διαδικασία της κωδικοποίησης γίνεται με το Adobe Media Encoder.   

Στην εφαρμογή αυτήν προσθέτουμε όσα βίντεο χρειαζόμαστε, παραμετροποιούμε το κάθε 

ένα ξεχωριστά και έπειτα τα μετατρέπουμε στην  μορφή που επιθυμούμε.  

Ξεκινάμε την εφαρμογή Adobe Media 
Encoder (Εικόνα 1) η οποία εγκαθίσταται 
στον ίδιο φάκελο προγραμμάτων με αυτόν 
του Flash. 
 
Κάνουμε κλικ στο κουμπί Add στο πάνω δεξί 
άκρο της εφαρμογής. 

Εικόνα 1 

 
 

Όταν προσθέσουμε το βίντεο, εμφανίζονται τα ακόλουθα στοιχεία σχετικά με αυτό  

(εικόνα 2). 

1. Source Name: Το όνομα του αρχείου. 
2. Format: Η μορφή του αρχείου, π.χ. FLV/F4V, την οποία επιλέγουμε κάνοντας κλικ 

στο κουμπί αριστερά του ονόματος. 
3. Preset: Προκαθορισμένοι τύποι μορφοποίησης ανάλογα με την μορφή αρχείου που 

έχουμε επιλέξει. Τον τύπο μορφοποίησης τον επιλέγουμε κάνοντας κλικ στο κουμπί 
αριστερά του ονόματος. Αν κάνουμε κλικ στο όνομα του preset, ανοίγει το πλαίσιο 
διαλόγου export settings με τις ρυθμίσεις εξαγωγής του βίντεο. Δες παρακάτω την 
ενότητα παραμετροποίηση του βίντεο. 

4. Output File: Κάνοντας κλικ, καθορίζουμε το όνομα και την τοποθεσία του 
εξαγώμενου αρχείου. 

5. Status: Η κατάσταση επεξεργασίας του βίντεο. 
 
Σημείωση: Μπορούμε να εξάγουμε όλα τα βίντεο μαζί, με ίδια ή ξεχωριστή μορφοποίηση 
για το κάθε ένα, κάνοντας κλικ στο κουμπί Start queue. 
 
Εικόνα 2 
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Παραμετροποίηση του βίντεο 

Αν κάνουμε κλικ στο όνομα του preset, ανοίγει το πλαίσιο διαλόγου export settings με 

πολλές ρυθμίσεις μετατροπής του βίντεο σε flash video. Οι ρυθμίσεις είναι οι ακόλουθες: 

 Έτοιμες επιλογές: Μπορούμε να αλλάξουμε τον τύπο μορφοποίησης και το όνομα 
του εξαγώμενου βίντεο, να καθορίσουμε εάν θα εξάγουμε βίντεο και ήχο ή κάποιο 
από αυτά. Τις επιλογές αυτές μπορούμε να τις αποθηκεύσουμε με το εικονίδιο save 
preset. 

 Περίληψη ρυθμίσεων εξαγωγής:  Βλέπουμε πληροφορίες σχετικά με το βίντεο και 
τον ήχο του. 

 Επιλογές αποκοπής: Μπορούμε να μοιόσουμε την ανάλυση του βίντεο επιλέγοντας 
crop και στην συνέχεια είτε να βάλουμε τιμές στα left, top κλπ, είτε να σύρουμε τις 
αντίστοιχες λαβές.  Στο κουμπί crop proportions υπάρχουν προκαθορισμένες 
αναλογίες των πλευρών της ταινίας. 

 Επιλογές κοπής: Εδώ βλέπουμε το μήκος του βίντεο το οποίο μπορούμε να 
μοιώσουμε κινόντας τις τριγωνικές λαβές. Μπρούμε να κινηθούμε μέσα στο βίντεο 
με χρήση της κεφαλής αναπαραγωγής και να το κόψουμε χρησιμοποιόντας τις 
λαβές. 

 Προχωρημένη κωδικοποίηση βίντεο και ήχου: Οι επιλογές αυτές ενεργοποιούνται 
κάνοντας κλικ κουμπί simple/advance mode της περιοχής έτοιμες επιλογές.  Αυτές 
περιλαμβάνουν φίλτρα, μορφοποίηση βίντεο, ρυθμίσεις βίντεο και ήχου. 

 Σημεία εκκίνησης: Οι επιλογές αυτές εφμανίζονται όταν έχουμε ενεργοποιήσει το 
κουμπί simple/advance mode. Στην περιοχή αυτή μπορούμε να εισάγουμε σημεία 
εκκίνησης (cue points). Πρόκειται για ειδικά σημάδια σε διάφορα σημεία του 
βίντεο στα οποία η κεφαλή αναπαραγωγής μπορεί να μεταβεί. Η χρήση τους 
υλοποιήτε μεσα από την γλώσσα προγραμματισμού action script. Με τον τρόπο 
αυτόν μπορούμε να φτιάξουμε μια διαδραστική ταινία. 

Εικόνα 3 

 
 

Όταν ολοκληρόσουμε πατάμε το κουμπί ΟΚ και Start Queue. 
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Εισαγωγή εξωτερικού βίντεο  

1. Ανοίξτε ένα υπάρχων έγγραφο Flash ή δημιουργήστε ένα νέο και αποθηκεύστε το. 

Σημείωση: Είναι σημαντικό να αποθηκεύσετε πρώτα το έγγραφο πριν ξεκινήσετε την 

διαδικασία εισαγωγής βίντεο. 

2. Επιλέξτε ένα καρέ στο επίπεδο στο οποίο επιθυμείτε να εισάγετε το βίντεο. 

Στο σημείο αυτό θα τοποθετηθεί το video player όταν εισάγετε το βίντεο. 

3. ΕπιλέξτεFile > Import > Import Video. 

Ανοίγει το παράθυρο Import Video 

(Εικόνα 1). 

 

Εικόνα 1 Το πλαίσιο διαλόγου Import Video με την σελίδα επιλογής βίντεο 

 

4. Εισάγετε την τοποθεσία του βίντεο. 

Το βίντεο μπορεί να βρίσκεται στον υπολογιστή (on your computer) σας ή στο internet (Already 

deployed…). Μπορείτε ακόμα και να αλλάξετε την κωδικοποίηση του βίντεο κάνωντας κλικ στο 

κουμπί Launch Adobe Media Encoder. 

 

5. Πατήστε Επόμενο. 

Ανοίγει η σελίδα Skinning του Import Video (Εικόνα 2). 

 

Εικόνα 2 Το πλαίσιο διαλόγου Import Video με την σελίδα Skinning 
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Η ρύθμιση Video Skin προσδιορίζει την θέση και την εμφάνιση των ελεγκτηρίων του 

παραθύρου αναπαραγωγής video όπως τα κουμπιά pause και play. Αυτά τα ελεγκτήρια 

εμφανίζονται όταν το video αναπαράγεται. Τα ελεγκτήρια μπορούν να εμφανίζονται πάνω ή 

στο κάτω μέρος του βίντεο. Μπροείτε να ορίσετε και το χρώμα τους στο πλαίσιο color. 

6. Επιλέξτε μια εμφάνιση από το μενού Skin και ένα χρώμα. 

7. Πατήστε Next. 

Ανοίγειησελίδα Finish Video Import. Σε αυτό το σημείο επιβεβαιώνεται η τοποθεσία του 

αρχικού αρχείου και του καινούριου βίντεο. 

8. Πατήστε Finish. 

Εκτελείται ο Flash Video Encoder. Όταν τελειώσει ο encoder, εμφανίζεται στο σκηνικό ένα 

αντικείμενο FLVPlayback το οποίο υπάρχει και στην βιβλιοθήκη. (Εικόνα 3). 

 

Εικόνα 3 Το αντικείμενο FLVPlayback πάνω στην σκηνή 

 

9. Επιλέξτε Control > Test Movie για να δείτε την ταινία να παίζει. 

Η ταινία παίζει στο μέσα στο παράθυρο του Flash. Παρατηρήστε ότι έχετε στην διάθεση σας 

στοιχεία ελέγχου της ταινίας όπως fast forward, rewind και αυξομείωσης της του ήχου. 

10. Επιλέξτε File>Close για να κλείσετε το παράθυρο προεπισκόπησης. 

11. Ανοίξτε τον κατάλογο στον οποίον αποθηκεύσατε το έγγραφο Flash. 

Παρατηρήστε ότι ο κατάλογος περιέχει δύο νέα αρχεία. Ένα αρχείο F4V και ένα SWF το οποίο είναι 

το Skin Video (Εικόνα 4) το οποίο μπορεί να καλείται όνομα_αρχείου.swf. Όταν έρθει ή ώρα να 

δημοσιεύσετε την ταινία σας, μαζί με το αρχείο flash πρέπει να έχετε στον ίδιο κατάλογο και αυτά τα 

δύο αρχεία.  

 

Εικόνα 4 Τα αρχεία F4V και SWF 

Μπορείτε να ρυθμίσετε κάποιες παραμέτρους του FLVPlayBack component μέσω του properties 

inspector κάνωντας κλικ στο κουμπί component inspector panel (εικόνα 5). Από την παλέτα αυτή 

μπορούμε να ελέγξουμε κάποιες παραμέτρους αναπαραγωγής του βίντεο όπως ο τρόπος 
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αναπαραγωγής, το skin κ.α. 

 

Εικόνα 5 Οι ιδιότητες του FLVPlayBack component 
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Ενσωμάτωση βίντεο 

Ενσωματώνοντας βίντεο μέσα σε αρχεία SWF 

Όταν επιλέξετε Embedded video, το Flash θα μετατρέψει το video σε καρέ στην λωρίδα 

χρόνου. Όταν το αρχείο SWF δημοσιευτεί, το video είναι πλήρως ενσωματωμένο σε αυτό 

και συνεπώς δεν υπάρχουν άλλα εξωτερικά αρχεία. Αυτό κάνει την διαδικασία εξαγωγής, 

εύκολη. Επειδή υπάρχει πρόβλημα συντονισμού του ήχου μετά από 120 δευτερόλεπτα 

αναπαραγωγής ή 16000 καρέ, η Adobe συστήνει αυτήν την μέθοδο μόνο στις ακόλουθες 

τρείς περιπτώσεις: 

 Όταν θέλετε να βλέπουν το βίντεο σας και οι επισκέπτες οι οποίοι έχουν παλαιά 

έκδοση του flash player. 

  Όταν πρέπει να έχετε ένα απλό αρχείο video 

 Όταν το video είναι μικρής διάρκειας 

Σε οποιαδήποτε άλλη περίπτωση, η μέθοδος ενσωμάτωσης video δεν προτείνεται. Ένα 

βίντεο ενσωματώνεται όταν έχει μετατραπεί σε FLV μέσω του Adobe Media Encoder.  

Παράδειγμα ενσωμάτωσης βίντεο 

1. Ξεκινάμε ένα νέο αρχείο το οποίο πρέπει να έχουμε αποθηκεύσει. 

2. Ξεκινάμε την διαδικασία εισαγωγής βίντεο επιλέγωντας File > Import > Video. Στο 

πλαίσιο διαλόγου Import Video επιλέγουμε On your computer > Embed FLV in SWF 

and play in timeline. Μπορούμε και πάλι να χρησιμοποιήσουμε τον Adobe Media 

Encoder για να αλλάξουμε την κωδικοποίηση (Εικόνα 1). 

 
3. Πατάμε Next 

4. Στο παράθυρο Embedding, επιλέγουμε εάν θα το εισάγουμε ως βίντεο ή σε έναν 

από τους γνωστούς τύπους συμβόλων. Ορίζουμε εάν η ταινία θα παίζει στο 

σκηνικό, εάν θα συμπεριλάβει τον ήχο και εάν θα επεκταθεί η λωρίδα χρόνου 

(εικόνα 2). 
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Η τελευταία επιλογή είναι απαραίτητη προκειμένου η ταινία να αναπαραχθεί μέσα 

στο σκηνικό. 

5. Πατάμε Next. 

6. Στην οθόνη Finish video import εμφνίζονται οι πληροφορίες αποθήκευσης και 

τοποθέτησης του αρχείου. 

7. Πατάμε Next. 

8. Το flash ολοκληρώνει την διαδικασία εισαγωγής του βίντεο στο σκηνικό (εικόνα 3). 

 
a. Το βίντεο έχει ενσωματωθεί στο σκηνικό,  

b. η λωρίδα χρόνου έχει επεκταθεί όση και η διάρκεια του βίντεο και  

c. το αντικείμενο εκτός από το σκηνικό υπάρχει και στην βιβλιοθήκη ως 

file_name.flv 

 

Σημειώσεις: 

1. Στο ενσωματωμένο βίντεο, δεν υπάρχουν ελεγτήρια ελέγχου της ταινίας. Στην 

περίπτωση αυτή, τα ελεγκτήρια πρέπει να φτιαχθούν από εμάς και να ορίσουμε τις 

ενεργειές τους με την action script.  

2. Παρατηρήστε ότι στον φάκελο αποθήκευσης του αρχείου, όπως είναι επόμενο, δεν 

υπάρχει κάποιο αρχείο skin όπως στην διαδικασία εισαγωγής εξωτερικού βίντεο. 

 


